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Release Notes for 
Lattice Diamond 3.9

Welcome to Lattice Diamond®, the complete design environment for Lattice 
Semiconductor FPGAs. Lattice Diamond design software offers leading-edge 
design and implementation tools optimized for cost-sensitive, low-power 
Lattice FPGA architectures.

Diamond is available for both the Windows and Linux operating systems. For 
details, see “System Requirements” on page 7.

This version of Diamond adds a variety of enhancements to make designing 
for Lattice Semiconductor programmable devices easier than ever. The 
design tools also include support for the latest Lattice Semiconductor devices. 
See “What’s New in Diamond 3.9” on page 2.

Lattice Semiconductor offers a rich variety of information sources, including 
the Help system, PDF manuals, tutorials, and online discussions. The easiest 
way to reach them all is through the online Help. The first topic in the Help 
provides links to all the other sources of information.

You can also find extensive information about Diamond and its capabilities, 
tools, and workflow on the Lattice Semiconductor website under:

www.latticesemi.com/latticediamond

../webhelp/eng/index.htm?context=Getting_Started&topic=Getting_Started
http://www.latticesemi.com/latticediamond


What’s New in Diamond 3.9

2 Release Notes for Lattice Diamond 3.9

What’s New in Diamond 3.9
This release of Diamond provides a variety of new features.

CrossLink Family Support - Power Calculator enhancements for more 
precise data for both normal and sleep mode operations

ECP5UM5G Family Support 

 Soft Error Injection (SEI) and LatticeMico support.

 SERDES parameters tuning for optimal performance.

ECP5U/UM Family Support 

 ECP5U-12K plus ASC, ECP5UM-25K/45K plus ASC device support

 SERDES parameters tuning for optimal performance.

MachXO2 Family Support - MachXO2HE devices with ASC device are 
generally available.

MachXO3LF Family Support

 MachXO3LF packages with ASC device is generally available.

 Package, Timing, SSO and IBIS hardware data files are in final status

MachXO3L/LF & MachXO2 - INBUF support - All input buffers of unused PIO 
and used outputs are disabled to save power when INBUF is set to OFF

Deployment Tool - Support added for STAPL file generation for ASC 
devices.

Diamond Programmer - Macronix SPI flash device support added to 
Diamond Programmer.

LatticeMico - Starting from Diamond 3.9, the LatticeMico installer will be 
starting from version 1.0 and remain until updates are made to LatticeMico

Supported Devices
Lattice Diamond can be used with either a free license or a subscription 
license. The two licenses provide access to different device families.

Device Family Free License Subscription License

ASC  

ECP5U  

ECP5UM 

ECP5UM5G 

LatticeEC™  
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Updating Projects from an Earlier Version
If you want to work on a design project created with an earlier version of 
Diamond, start with the following procedures. These procedures adapt the 
project for the changes in Diamond.

Find out which version of Diamond your project was created with. Then work 
through the changes for that and every later version, starting with the earliest 
and going to the most recent. For example, if your project was created with 
Diamond 1.1, you would start with the changes for 1.1. After completing those 
changes, you would work on the changes for 1.2, then 1.4, and so on.

When you open a project from Diamond 1.2 or earlier, Diamond opens a 
dialog box warning that Diamond will automatically move all SDC files to the 
Synthesis Constraint Files folder in File List view and remove the “Input SDC 
Constraint File” options from the strategies. If the project is using LSE, the file 
names will be changed to use an .ldc extension.

Once saved, the project will not be compatible with earlier Diamond versions.

LatticeECP™  

LatticeECP2™  

LatticeECP2M™ 

LatticeECP2S 

LatticeECP2MS 

LatticeECP3™ 

LatticeSC™ 

LatticeSCM™ 

LatticeXP™  

LatticeXP2™  

LIFMD (CrossLink)  

MachXO™  

MachXO2™  

MachXO3L  

MachXO3LF  

Platform Manager™  

Platform Manager 2  

Device Family Free License Subscription License
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2.2 Projects
ECP5 does not use the CIN port of the CCU2C Carry Chain primitive. This 
port should not be connected to anything. If the port is connected, the Design 
Map stage will fail with an error message. If you see such a failure, correct the 
design in one of the following ways:

 Rerun synthesis. This should correct the problem if the CCU2C primitive 
is part of an IPexpress module.

 If the CCU2C primitive was added to your HDL manually, edit the code to 
remove the connection. See the following examples:

In Verilog:

CCU2C addsub_0 (.A0(scuba_vlo), .A1(DataA[0]), 
.B0(scuba_vlo), .B1(DataB[0]), .C0(scuba_vhi), 
.C1(scuba_vhi), .D0(scuba_vhi), .D1(scuba_vhi), 
.CIN(), .S0(), .S1(Result[0]), .COUT(co0));

In VHDL:

signal tmp: std_logic := 'X';
cnt_cia: CCU2C 

generic map (INJECT1_1=> "NO", INJECT1_0=> "NO", 
INIT1=> X"0000", INIT0=> X"0000") 
port map (A0=>scuba_vhi, A1=>scuba_vhi, B0=>scuba_vhi,
B1=>scuba_vhi, C0=>scuba_vhi, C1=>scuba_vhi,
D0=>scuba_vhi, D1=>scuba_vhi, 
CIN=>tmp, S0=>open,S1=>open, COUT=>cnt_ci);

2.0.1 Projects
Several strategy options have new default values. If you are using Synplify 
Pro in integrated mode (running synthesis automatically in Diamond), check 
that the following settings are still as you want them. Also, check the setting of 
the Auto Hold-Time Correction option under Place & Route Design. Its default 
changed to On for all devices. This is still current in Synplify Pro versions.

Table 1: New Default Values for Synplify Pro for Lattice

Option Before Now

Fanout Limit is now Fanout 
Guide

100 1000

Export Diamond Settings to 
Synplify Pro GUI (new in 2.2)

Not available No

Fix Gated Clocks and Fix 
Generated Clocks combined 
into new Clock Conversion

3 (converts and reports all 
sequential elements)

True (converts with no 
report)

Frequency 200 auto (blank means “auto”)

Number of Critical Paths 3 blank (unspecified)

Number of Start/End Points 0 blank (unspecified)
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1.4 Projects
For Diamond 1.4 and earlier, there might be some constraints that are not 
honored because of the Synplify Pro cross-probing feature. This EDIF 
renaming is usually related to bus names.

If such a problem occurs, you can turn off the renaming feature by placing the 
following line in the “Command line Options” text box of the Synplify Pro 
section of the active strategy:

set_option -syn_edif_array_rename 0

1.2 Projects
There were several enhancements for IP and MachXO2.

IP Incompatibilities
SPI4.2 2.7 is not compatible with Diamond 1.3 or later. If you are using this IP, 
check the Lattice Semiconductor Web site for a more recent version.

MachXO2 Changes
See if your design involves any of the following features:

 For EFB modules with user flash memory (UFM), regenerate the module.

 For IO_TYPE=PCI33 on a MachXO2-1200 or larger device, check if the 
CLAMP is using the default setting. With Diamond 1.3 the CLAMP default 
changes from ON to PCI and the I/O will be placed in bank 2. If you were 
using the default and still want the setting to be ON, you need to set it 
explicitly.

 For PCI33 MT 6.5 and PCI33 T 6.4 IP, either set the CLAMP to ON 
explicitly or choose a bigger package (256 or more).

Output Preference File False True

Pipelining and Retiming False Pipelining Only

Resolved Mixed Drivers True False

Use Clock Period for 
Unconstrained I/O

True False

Table 1: New Default Values for Synplify Pro for Lattice (Continued)

Option Before Now
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1.1 or 1.0 Projects
There were several enhancements for IP and MachXO2.

IP Incompatibilities
The following IP versions are not compatible with Diamond 1.2 or later. If you 
are using any of these IP, check the Lattice Semiconductor Web site for a 
more recent version.

ECP5 Support
For ECP5U and ECP5UM designs, for better EBR and SERDES tuning and 
DSP/Distributed RAM control for constant process, it is a necessity to 
recompile your design using the current release of Diamond.

MachXO2 Support
Some aspects of the software support for MachXO2 designs have been 
improved. See if your design involves any of the following features:

 The 4K/7K design with PLL has a CIB-to-PLL jump change. If you are 
using this design, recompile it.

 The EFB simulation model has changed. If you are using the EFB module, 
rerun your simulation tests to see more accurate results.

 In the DDR_GENERIC module of IPexpress, the GDDRX1_RX.Aligned 
with PLL interface is no longer supported. If you are using such a module, 
use IPexpress to regenerate it without the PLL option.

Also, MachXO2 has IP evaluation capability and TransFR mode for all I/Os.

Migrating ispLEVER Projects
Diamond uses a different project structure than ispLEVER and cannot directly 
open an ispLEVER project. However, design projects created in ispLEVER 
can easily be imported into Diamond. The process is automatic except for the 
ispLEVER process properties, which are similar to the Diamond strategy 
settings, and some modules and IPs. All of your ispLEVER project source will 
be automatically handled.

 Convolution Block Encoder 3.6

 DDR1 6.9

 DDR2 7.1

 DDR3 1.2.1

 DDR1_CP 1.1 with MachXO2

 DDR2_CP 1.1 with MachXO2

 Interleaver Deinterleaver 3.5

 PCI_MT_33 6.4

 PCIe RC Lite 1.2

 Tri-Speed MAC 3.4

 Viterbi Block Decoder 4.6
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Projects created using ispLEVER can be imported into Lattice Diamond 
through two different paths:

 On the Start Page, click Import ispLEVER Project (in the upper-left 
corner).

 From the File menu, choose Open > Import ispLEVER Project.

Follow the directions in the dialog box that opens to convert your ispLEVER 
project into a Lattice Diamond project.

Limitations to the import/conversion process include:

 NGO files in ispLEVER projects need to be manually copied into the 
Lattice Diamond project if the NGO files were originally copied into the 
ispLEVER project. For example, NGO files that were copied from Lattice 
IP generation.

 The .lpc files are replaced with .ipx files in Lattice Diamond. You need to 
regenerate your IP by double-clicking on the .lpc file. The resultant wizard 
will help you generate the new .ipx file, replacing the old .lpc file.

More information on importing ispLEVER projects can be found in the Lattice 
Diamond User Guide, online Help (see Managing Projects > Importing 
ispLEVER Projects), and training videos on the Lattice Web site.

Other Information Resources
Other available information resources for the Diamond software include the 
following.

 General Information: General information on Lattice Diamond can be 
found on the Lattice Web site at:

www.latticesemi.com/latticediamond

 Online Help: Start Lattice Diamond and choose Help > Lattice Diamond 
Help.

 Lattice Diamond User Guide: This document can be found from a link on 
the Start Page view.

 Training Videos: Several short videos are available on different aspects of 
the Lattice Diamond software. These can be viewed online at:

www.latticesemi.com/latticediamond

Click the Videos tab.

System Requirements
The basic system requirements for Lattice Diamond are:

 Intel Pentium or Pentium-compatible PC, or AMD Opteron system support 
(Linux only)

http://www.latticesemi.com/latticediamond
http://www.latticesemi.com/latticediamond
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 CPU with the SSE3 instruction set to run the Aldec Active-HDL Lattice 
Edition simulator

 One of the following operating systems:

 Windows Vista (32-bit), Windows 7 (32-bit or 64-bit), Windows 8 (32-
bit or 64-bit, including Windows 8.1), or Windows 10 (32-bit or 64-bit).

 Red Hat Enterprise Linux 4, 5, 6 or 7. The host operating system is 
supported in 64-bit only. 

Version 5.3 of Red Hat Enterprise Linux has some extra installation 
requirements. See “Configuring Red Hat 5.3” on page 9.

 Approximately 5.75 GB free disk space

 RAM adequate for your FPGA design. For guidelines see “Memory 
Requirements” on page 8.

 Network adapter and, for a floating license, network connectivity

A node-locked license is based on the physical (hard-coded) address 
provided by the network adapter. Network connectivity is not required for a 
node-locked license. In the absence of a network connection, you can 
install the NWLink IPX/SPX protocol to force recognition of your NIC card 
ID (see the Installation Notice).

A floating license requires access to the license server, so both a network 
adapter and connectivity are required.

 JavaScript-capable Web browser

 Microsoft Internet Explorer 8 or higher if using the included Aldec Active-
HDL Lattice Edition simulator

 Acrobat Reader 5.0 or later

Memory Requirements
Table 2 lists the minimum memory requirements and the recommended 
memory for the Lattice Semiconductor devices supported by Diamond.

On Windows, designing for the largest FPGAs may require more than the 
usual 2 GB of memory found in 32-bit computers. For help in extending your 
memory to 3 GB, see “Extending Memory on Windows” on page 9. Designing 
for LatticeECP3 with more than 95K LUT on a Windows system requires a 64-
bit operating system.

Table 2:  Recommended Memory

Device Size 32-Bit Operating Systems 64-Bit Operating Systems

Minimum Recommended Minimum Recommended

ECP5U/UM/UM5G All 2 GB 3 GB 4 GB 6 GB

LatticeEC, LatticeECP Up to 20K LUT 512 MB 768 MB 1 GB 1.5 GB

Up to 50K LUT 768 MB 1 GB 1.5 GB 2 GB
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Extending Memory on Windows
Designing for LatticeECP3 or ECP5 may require more than the 2 GB normally 
available with 32-bit Windows systems. But you can configure Windows to 
use up to 3 GB of memory.

Note that increasing the amount of memory available to applications 
decreases the amount available for the file cache, paged pool, and nonpaged 
pool, which can affect applications with heavy networking or I/O.

Use the BCDEdit /set increaseuserva 3072 command to set the boot 
entry option to 3 GB. For details, see Microsoft article “BCDEdit /set”:
msdn.microsoft.com/en-us/library/ff542202.aspx

Configuring Red Hat 5.3
Red Hat Enterprise Linux 5.3 has some extra requirements for Diamond:

 In addition to the basic installation of Red Hat 5.3, under Development/ 
Legacy Software Development, select:

1:gtk+-1.2.10-56.el5.i386 - GIMP Toolkit (GTK+) sb:(9 of 9)

Under Base System/Legacy Software Support, add the following to the 
default items:

LatticeECP2/M Up to 20K LUT 768 MB 1 GB 1.5 GB 2 GB

Up to 50K LUT 1 GB 1.5 GB 2 GB 3 GB

Up to 100K LUT 1 GB 2 GB 2 GB 4 GB

LatticeECP3 Up to 95K LUT 2 GB 3 GB 4 GB 6 GB

Up to 150K LUT 3 GB 4 GB 6 GB 8 GB

LatticeSC/M Up to 40K LUT 768 MB 1 GB 1.5 GB 2 GB

Up to 115K LUT 1 GB 2.5 GB 2 GB 5 GB

LatticeXP, LatticeXP2 Up to 20K LUT 512 MB 768 MB 1 GB 1.5 GB

Up to 50K LUT 768 MB 1 GB 1.5 GB 2 GB

MachXO, MachXO2, 
MachXO3L

All 256 MB 512 MB 512 MB 1 GB

LIFMD (CrossLink) All 256 MB 512 MB 512 MB 1 GB

Platform Manager, 
Platform Manager 2

All 256 MB 512 MB 512 MB 1 GB

Table 2:  Recommended Memory (Continued)

Device Size 32-Bit Operating Systems 64-Bit Operating Systems

Minimum Recommended Minimum Recommended

http://msdn.microsoft.com/en-us/library/ff542202.aspx
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Openmotif22-2.2.3-18.i386 - Open Motif runtime

Proper Diamond operation depends upon these libraries being installed.

 When installing the Red Hat Enterprise Linux version, be sure to install the 
PERL modules XML::Parser, XML::DOM, and XML::RegExp. These 
PERL modules are available at www.cpan.org.

Issues Fixed
The following known issues are fixed with this release. Their workarounds are 
no longer needed. For the complete list of known issues, see
www.latticesemi.com/view_document?document_id=50676

Deployment Tool crashes when generating 
CrossLink Bitstream file
Generating a JED file causes a crash to the Deployment Tool.

Versions affected: Diamond 3.9
Devices affected: CrossLink
Fixed_3.9
CR127403

SPI Flash Programming issues when using RHEL 
7.2 O/S
When programming the SPI Flash on a LatticeECP5 Versa board, the 
operation is stuck in the verifying stage when using RHEL 7.2.

Versions affected: Diamond 3.9
Devices affected: LatticeECP5UM
Fixed_3.9
CR127391

Quad SPI configuration does not function for 
LatticeECP5 using Spansion Flash FL164KIF01
The Quad I/O capable SPI flash from Spansion is a supported flash, but is not 
configured by the Programmer for Quad I/O boot.

Versions affected: Diamond 3.9
Devices affected: LatticeECP5UM
Fixed_3.9
CR126436

http://www.cpan.org
www.latticesemi.com/view_document?document_id=50676
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Known Issues
Following are known issues with this release and workarounds for them. For 
the complete list, see:
www.latticesemi.com/view_document?document_id=50676

SG-DMA v3.1 and Tri-Speed Ethernet MAC v4.1 do 
not meet target fMAX
Due to the packaging of the IPs only running PAR with 1 seed in the 
evaluation project, a user may need to run the evaluation project in some IPs 
including the above with more than 1 seed before Diamond will meet the 
desired target frequency.

Versions affected: Diamond 3.9
Devices affected: All
CR126039

Synplify replicates certain control signals for 
timing improvement, which causes MAP failure 
(LatticeECP3)
A workaround is to put a syn_keep attribute on the CE (clock enable) signal. 
This defect is acknowledged by the vendor Synopsys which will provide a fix 
by the next release of Diamond. 

Versions affected: Diamond 3.9
Devices affected: LatticeECP3
CR127002

IPs CPRI v5.2 (LatticeECP3) and Tri-Speed Ethernet 
MAC v4.1 (LatticeXP2) cause errors during 
synthesis
When synthesizing the above IPs with Synplify or LSE, a user may run into 
semantic errors in some IPs including the above such as unqualified net 
names which may causes preferences to not be called. Such semantics must 
be manually fixed until an updated packaged version of the IP is released.

Versions affected: Diamond 3.9
Devices affected: LatticeECP3, LatticeXP2
CR124134

http://www.latticesemi.com/view_document?document_id=50676
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Lattice Synthesis Engine (LSE) may have lower 
fMAX on synthesis of IPs
Some IPs in Diamond are optimized for Synplify and hence the fMAX 
performance with LSE may be lower. Use Synplify as workaround.

Versions affected: Diamond 3.9
Devices affected: All

FSM Gray encoding may cause issues with LSE 
Synthesis
When synthesizing gray encoding style with LSE synthesis tool, an incorrect 
state may be transitioned. To work around the issue a user can change the 
active strategy as follows:

1. In Diamond, choose Project > Active Strategy > LSE Settings. 

2. In the Strategies dialog box, set FSM Encoding Style value to Binary.

Versions affected: Diamond 3.9
Devices affected: All
CR127472

CrossLink LVCMOS3.3 IO may report error that 
design does not meet 300Mhz requirement for pixel 
clock port
The CrossLInk datasheet recently increased the LVCMOS33 IO’s fMAX from 
250 Mhz to 300 Mhz. Diamond v3.9 timing models have not been updated to 
support this increase. If the user has a timing constraint for a LVCMOS33 IO 
running higher than 250 Mhz, a timing violation will be reported by the timing 
analysis tool. This violation can be ignored because all of the internal timing 
will still be closed correctly by the tool. This issue will be addressed in a future 
Diamond release.

Versions affected: Diamond 3.9
Devices affected: CrossLink
CR127535
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Some Intellectual Property (IP) modules may not 
meet targeted timing on LatticeECP3 or LatticeXP2 
devices
Some IP modules may not meet targeted fMAX when used with LatticeECP3 
or LatticeXP2 devices. The following table lists the IP and affected devices:

If you need assistance with this issue, contact Lattice Technical Support.

Versions affected: Diamond 3.9 
Devices affected: LatticeECP3, LatticeXP2

Contacting Technical Support

FAQs The first place to look. The Answer Database on the Lattice 
Semiconductor Web site provides solutions to questions that many of our 
customers have already asked. Lattice Applications Engineers are 
continuously adding to the Database.

Technical Support Assistance Submit a technical support case via 
www.latticesemi.com/techsupport.

For Local Support Contact your nearest Lattice Sales Office

IP LatticeECP3 LatticeXP2

2.5G Ethernet PCS 

JESD207 

PCI Master Target 66 

PCI Target 66 

PCS PIPE 

SRIO 

DDR2 SDRAM Controller 

Trademarks
All Lattice trademarks are as listed at www.latticesemi.com/legal. Synopsys and Synplify Pro are trademarks of 
Synopsys, Inc. Aldec and Active-HDL are trademarks of Aldec, Inc. All other trademarks are the property of their 
respective owners.

http://www.latticesemi.com/support/answerdatabase.aspx
http://www.latticesemi.com/legal
http://www.latticesemi.com/buy/saleslocator.aspx
http://www.latticesemi.com/techsupport
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